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Die Informationen in diesem Buch werden ohne Rücksicht auf einen eventuellen Patentschutz veröf-
fentlicht. Warennamen werden ohne Gewährleistung der freien Verwendbarkeit benutzt. Bei der Zu-
sammenstellung von Texten und Abbildungen wurde mit größter Sorgfalt vorgegangen. Trotzdem kön-
nen Fehler nicht ausgeschlossen werden. Die Autorin kann für fehlerhafte Angaben und deren Folgen 
werder eine juristische Verantwortung noch irgendeine Haftung übernehmen. Für Verbesserungsvor-
schläge und Hinweise auf Fehler ist die Autorin dankbar.
Logos von den Hardware und Software Herstellern sind von den jeweiligen Websites entnommen.

folgende Bilder wurden von https://www.elegoo.com/download/ entnommen:
Bauteile: IR Sensor,  Temperatur und Feuchtigkeitssensor, Stepper Motor, DC Motor, Druckknöpfe, 
Water Level Sensor, Piezo Lautsprecher

folgende Bilder wurden von der deutschen und englischen Wikipedia entnommen:
Bauteile: Lichtsensoren, LEDs, Transistoren, Kondensatoren, Widerstände, Lichtspektrum

folgende Bilder wurden von https://www.adafruit.com entnommen:
Bauteile: flora, gemma
Projekt: Beweg-Dich-Armband, Ampli-Tie

folgende Bilder wurden von https://www.instructables.com entnommen:
Bauteile: flora, gemma, 
Projekt: Projekt Sonic Scarf, Weather Station

Schaltsymbole und Vektorgrafiken von Schaltmodellen wurden aus der Software 
fritzing und circuito.io entnommen

Grafiken wurden von freepik.com entnommen
Grafiken der Schulfächer basieren auf: School vector, ibrandify und macrovector created by freepik

folgende Platinen und Bauteile wurden von Sparkfun https://www.sparkfun.com entnommen (sie 
stehen unter CC Lizenz):
Arduino, LilyPad, Raspberry Pi 3, Makey Makey, LilyPad USB Breakout

Bilder und Grafiken von Lisa Kuka:
Multimeter, Grafik Ohm'sches Gesetz und Wassertanks (angelehnt an Sparkfun Grafiken), Bilder zu 
Blackout Poetry, "Stein, Schere, Papier" und DIY-Surgery, Screenshots Arduino IDE
Gaming Console: Bilder der Controller

Bilder von Bianca Lindorfer:
Gaming Console: Work-in-Progress Bilder

Titelseite: Verwendet Grafik-Elemente pikisuperstar / Freepik & 
Photo by cottonbro from Pexels
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Einleitung
Als Lehrkraft stellt man sich zwangsläufig die Frage, wieviel von dem was man den Schülern und 
Schülerinnen mit auf den Weg gibt, tatsächlich hängen bleibt – also was in ein paar Jahren noch 
vorhanden sein wird. Das sogenannte Binge Learning – also das sture auswendig Lernen von Prü-
fungsstoff um ihn dann bei der Prüfung wieder “auszukotzen” und anschließendem Vergessen – ist 
wohl für alle Beteiligten, reine Zeitverschwendung. Zeit, die Schüler und Schülerinnen sowie Lehr-
kräfte sinnvoller nutzen hätten können, wie auch die Lehrkräfte. Nichts ist frustrierender als der 
Gedanke unnötig Zeit verbracht zu haben. 

Dieses Handbuch versucht, Ideen rund um Single-Board Platinen zu geben um einen fächerüber-
greifenden Unterricht zu ermöglichen. Der Ruf nach digitalen Kompetenzen wird immer lauter, die 
Frage ist jedoch, wie diese am besten vermittelt werden können. 
Die Informatik ist seit jeher eine interdisziplinäre Disziplin gewesen, sie bietet viele Überschneidun-
gen mit anderen Fächern. Ihr volles Potential kann also erst in fächerübergreifender Projektarbeit 
entfaltet werden. Hierbei ist zu beachten, dass das Rad nicht neu erfunden werden muss. Unzählige 
Communitys bieten online bereits eine Vielzahl an Projektideen, sie müssen von Lehrkräften ledig-
lich aufgegriffen werden und mit didaktischen Überlegungen verknüpft werden. Das bietet auch den 
Vorteil, dass Schüler und Schülerinnen einen kritischen, produktiven Umgang mit dem Internet ler-
nen. Das Internet bietet also nicht nur lustige Katzenvideos und verleitet zu kriminellen Aktivitäten, 
nein – ganz im Gegenteil – es bietet Tutorial und eine immense Menge an Informationen, die nur 
darauf warten, entdeckt und weiterentwickelt zu werden. 

Das Handbuch baut auf Erkenntnissen der Neurodidaktik auf, die wichtigsten sind in den 
12-Lehr-Lern-Prinzipien von Caine zusammengefasst. Diesen Prinzipien hat sich auch das 
COOL-Konzept verschrieben. Unterricht sollte kooperativ, offen und computer-unterstützt sein, da-
durch wird er einfach COOL. Das Schüler und Schülerinnen Freude am Lernen haben sollten, geht 
nicht auf eine Kuschel- oder Hippiepädagogik zurück, so wie von Kritiker*innen gerne behauptet, 
sondern auf einen Erfahrungsschatz von Pädagog*innen, der heute durch die Neurodidaktik un-
termauert werden kann. Freude und positive Emotionen, aber auch sinnhafte Praxiserfahrungen 
fördern das Lernen. Außerdem ist unser Gehirn sozial. Diese Erkenntnisse schreien förmlich nach 
offenen interdisziplinären Projekten.

Weiters stellt das Handbuch keine genaue 
Schritt-für-Schritt Anleitung dar. Dem For-
schungsgeist soll nicht im Weg gestanden 
werden. Die Projekte sind grob beschrie-
ben und sollen inspirieren. Experimentieren 
und auch Fehler zu machen  ist erwünscht.

Viel Spaß

Dipl.-Ing. Lisa Kuka

► 12-Lehr-Lern-Prinzipien nach Arnold und Caine
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Im digitalen Zeitalter sollte jeder und jede über Cre-
ative-Commons-Lizenzen Bescheid wissen. Cre-
ative Commons hilft, legal Wissen und Kreativität 
zu teilen, um eine Welt zu schaffen, in der besser-
er Zugang zu Informationen und Innovationen 
gewährleistet wird. Creative-Commons-Lizenzen 
wollen das volle Potential des Internets ausnützen, 
um im Informationszeitalter neue Entwicklungen 
und Produktivität zu steigern.  

Eine CC-Lizenz erleichtern es, selber zu entsc-
heiden, welche Rechte man behalten möchte und 
was man anderen erlaubt – und das ganz einfach 
und unkompliziert. Diese Lizenzen ermöglichen es, 
freie, einfach zu benützende und urheberrechtlich 
geschützte Lizenzen zu erzeugen, um der Öffen-
tlichkeit eine Möglichkeit zu bieten, kreative Arbeit-
en zu teilen und zu benutzen. Werke, die mit einer 
Creative-Commons-Lizenz ausgestattet sind, dür-
fen also vervielfältigt, verbreitet, verändert und in 
neue Werke integriert werden. 

AutorIn muss immer gen-
annt werden

NC
Nicht kommerziell

Kann verwendet werden, 
aber ohne Geld damit zu 
verdienen

ND
Keine Bearbeitung

Keine Veränderungen 
erlaubt

SA
Weitergabe unter 

gleichen Bedingungen
Darf nur verwendet 
werden, wenn das neue 
Werk unter derselben 
Lizenz geführt wird

BY
Namensnennung

Mehr Informationen unter https://creativecommons.org/

Das Internet macht es einfach, kreative Werke von anderen zu teilen und darauf aufzubau-
en - allerdings stellen Gesetze oftmals eine Hürde dar. Immer wenn man ein Foto macht, 
ein Lied aufnimmt oder einen Artikel veröffentlicht, dann steht dieses Werk laut Urheber-
rechtsschutz automatisch unter “All right reserved” .  Das bedeutet, dass andere es nicht 
wiederverwenden oder abwandeln (remixen) dürfen ohne vorher eine Erlaubnis einzuholen. 
Was ist aber, wenn man als Urheber*in möchte, dass es benutzt wird?

Von “All rights reserved” zu “Some rights reserved”

Fragen zur Lizenzwahl laut CC Website:
• Soll es anderen möglich sein, meine Werke kommerziell zu nutzen oder nicht?
• Soll es anderen möglich sein, meine Werke abzuwandeln und zu verändern?
• Weitergabe unter denselben Bedingungen: wenn es erlaubt ist, mein Werk abzuwandeln, kann auch darüber ent-

schieden werden, ob das neue Werk unter derselben CC-Lizenz zur Verfügung gestellt werden soll. 

Es gibt eine Vielzahl an unterschiedlichen Cre-
ative-Commons-Lizenzen. Sie teilen jedoch alle 
gewisse wichtige  Eigenschaften. Beispielsweise 
bieten sie die Möglichkeit, das eigene Werk urhe-
berrechtlich zu schützen und trotzdem anderen 
die Möglichkeit zu geben, dieses zu benutzen, 
weiterzuentwickeln oder anderweitig zu nutzen - 
für nicht-kommerzielle Zwecke. Die Lizenz stellt 
außerdem sicher, dass dem Lizenzgebenden die 
gebührende Anerkennung zuteil wird. Weiters 
sind sie weltweit einsetzbar und erlöschen mit 
dem gesetzlichen Urheberrecht. Jede CC-Lizenz 
kann zusätzlich mit Erlaubnissen ausgestattet 
werden, die die genauen Nutzungsbedingungen 
festlegen.

Das eigene Copyright wird dadurch also von “All 
rights reserved” zu “Some rights reserved abge-
wandelt.

Creative Commons
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Single-Board Platinen

Der Arduino ist ein open source Mikrocon-
troller Board. Er stellt digitale und analoge 
Ein- und Ausgänge zur Verfügung, über 
die sich Sensoren und Motoren ansteuern 
lassen. Für die Programmierung gibt es 
eine eigene Arduino IDE, über die sich per 
Knopfdruck der Sketch (das Programm) 
auf den Arduino hochladen lässt. Es gibt 
eine große Community und eine Vielzahl 
an Startersets und Literatur.

Arduino

LilyPad

Das LilyPad ist im Grunde genommen 
nichts anderes als ein Arduino, nur in ei-
ner anderen Form. Es wurde konzipiert, 
um auf Kleidung und Stoffen aufgenäht zu 
werden. Die analogen und digitalen Pins 
sind im Kreis angeordnet und lassen sich 
mit leitfähigen Garn verbinden. Außerdem 
gibt es eine Vielzahl an elektronischen 
Teilen, die oftmals schon Vorwiderstände, 
etc integriert haben und sich somit leichter 
vernähen lassen. Das Thema Wearables 
wird hier groß geschrieben.

Single-Board Platinen

► https://www.arduino.cc

► https://www.arduino-tutorial.de
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► https://www.arduino.cc

► https://www.arduino-tutorial.de

Raspberry Pi

Makey Makey

Der Raspberry Pi ist ein Einplatinencom-
puter. Er bietet nicht nur einige Pins über 
die – wie beim Arduino – Sensoren und 
Motoren angesteuert werden können, son-
dern auch SD-Karten Slot, USB-Ports und  
einen HDMI-Port. Er benötigt außerdem 
ein Betriebssystem. Somit ist der "Raspi" 
ein vollwertiger Computer. Auch er bietet 
eine große Community, viele verschiede-
ne Startersets und Literatur. 

Das Makey Makey ist eine Leiterplatine. 
Es kann über USB an den Computer an-
geschlossen werden und wird als Einga-
begerät erkannt. So können leitfähige Ge-
genstände – wie beispielsweise Bananen 
– zu einem Controller umgebaut werden. 
Die Handhabung ist sehr einfach und so 
können selbst Kinder damit problemlos 
umgehen.
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► https://makeymakey.com

► https://colleengraves.org/tag/makeymakey/

► https:// www.raspberrypi.org 

► https:// tutorials-raspberrypi.de

► https://www.instructables.com

► https://learn.sparkfun.com/tutorials

► https://www.adafruit.com
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Software

Softw
are

Arduino IDE
Um den Arduino zu programmieren, ist eine Entwick-
lungsumgebung (Integrated Development Environment) 
nötig. Sie ist gratis und ermöglicht den leichten Einstieg 
in die Programmierung. Man lernt auch, dass man das 
Rad nicht immer neu erfinden muss und dass man be-
reits fertigen Code einbetten darf, um in zu verwenden, 
aber auch weiterzuentwickeln. Eine Vielzahl an Bibliothe-
ken ermöglicht eine einfache Programmierung von Mo-
toren, etc. 

► https://www.arduino.cc/en/Main/Software

Scratch
Scratch ist eine einfache, grafische Programmierungs-
umgebung, die vom MIT entwickelt wurde, um Kindern 
das Programmieren näher zu bringen. Es können sehr 
einfach Spiele entwickelt werden, indem Blöcke (die für 
einfache Befehle stehen) per drag&drop miteinander ver-
bunden und verschachtelt werden. Auch das Aufnehmen 
von Sprache ist ein Leichtes und eignet sich dadurch in 
Kombination mit dem Makey Makey dafür Sounds abzu-
spielen.
Das Betriebssystem Raspbian (Raspberry Pi) liefert eine 
etwas abgespeckte Version von Scratch mit.
► https://scratch.mit.edu/download

MIT App Inventor
Der MIT App Inventor ist eine browserbasierte APP Ent-
wicklungsumgebung, mit der es möglich ist, einfache 
Android Apps zu erstellen. Vor allem, wenn man seinen 
Arduino mit einem Bluetooth Modul vom Smartphone aus 
steuern möchte, muss man dazu in der Regel eine App 
programmieren. Der MIT App Inventor baut dabei – wie 
Scratch – auf einer modularen Programmierung mit eige-
nen Blöcken auf, die einfach zusammengestöpselt wer-
den können.

► http://ai2.appinventor.mit.edu
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App – kurz für Applikation und beschreibt im Allgemeinen 
ein Programm auf einem Tablet oder Smartphone

browserbasiert – es ist keine Installation auf dem Com-
puter nötig

Entwicklungsumgebung oder IDE – (Integrated Develop-
ment  Environment,) Software mit der man programmie-
ren kann

open source – Software oder Hardware, die frei zugäng-
lich ist. Das bedeutet der Code oder Schaltplan ist frei 
einsehbar und das Weiterverarbeiten ist nicht nur erlaubt, 
sondern erwünscht

Fritzing
Fritzing ist eine open source Software, die das Erstellen 
von Schaltplänen erlaubt. Es steht eine große Bibliothek 
mit Bauteilen zur Verfügung. Dabei gibt es nicht nur Stan-
dardbauteile wie LEDs und Widerstände, sondern auch 
Platinen und Spezialbauteile von bekannten Herstellern 
wie Arduino und Sparkfun. Die bildhaften Darstellun-
gen werden von der Software auch in Schaltpläne mit 
genormten Schaltzeichen umgewandelt. Mit Fritzing las-
sen sich die eigenen Projekte leicht dokumentieren und 
auch für andere zugänglich machen.  

► http://fritzing.org/ download
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Circuito.io

► https://www.circuito.io/

Circuito ist eine browserbasierte Software, dies es – wie 
Fritzing – ermöglicht Schaltpläne zu erstellen. Allerdings 
stellt sie zusätzlich Beispielcode zur Verfügung und er-
stellt eine Shopping Liste. Der Clou bei Circuito besteht 
außerdem darin, dass die Software mitdenkt, das heißt 
füge ich beispielsweise eine LED hinzu, findet die Soft-
ware eigenständig den passenden Widerstand und 
nimmt die Verbindungen selbstständig vor. Das kann für 
Anfängerinnen und Anfänger hilfreich sein.
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Making
Seit vielen Jahren kann nun ein Aufblühen der Maker Szene beobachtet werden, vor allem ange-
trieben durch technologische und gesellschaftliche Entwicklungen wie das Web 2.0, erschwingliche 
Mikrocontroller und Einplatinencomputer, die Open Source Idee, sowie den Unbehagen passiver 
Konsument zu sein. Makers designen, programmieren und konstruieren. Dabei steht der Wis-
sensaustausch und das gemeinsame Teilen von Ressourcen im Mittelpunkt. Diese Communitys 
haben durch das Internet Aufschwung erfahren. Das Tüfteln wird durch Zurschaustellung ergänzt. 
Nicht nur im Internet, auch auf Maker Faires und Ausstellungen kann sich Inspiration und Rat geholt 
werden (Katterfeldt, Zeising & Lund, 2013, 123f).
Auch die Lerntheorie des Konnektivismus, begründet von George Siemens, postuliert eine neue 
Sichtweise auf das Lernen. In Zukunft verliert das reine Auswendiglernen von Fakten und Hand-
lungsweisen (das Was und Wie) an Bedeutung und das Auffinden von Wissen (Wo) nimmt zu. Grün-
de dafür liegen in der ständig wachsenden Informationsflut und dem immer schnelleren Verfall von 
Wissen durch technologische Entwicklungen. Wissen wird als Netzwerk mit Knoten und Bindungs-
punkten verstanden. Das bedeutet auch, dass die Wichtigkeit an informellem, vernetztem Wissen 
durch elektronisch gestütztes Lernen zunimmt. Dadurch entstehen "Communities of Practice", die 
sich gemeinsam Wissen erschließen und auch wieder weitergeben. Metakompetenzen, wie Un-
wichtiges von Wichtigen zu unterscheiden und vertrauensvolle Quellen zu überprüfen gewinnen 
an Bedeutung (Siemens, 2005, S. 3-10; iMoox, 2019, 10:35). Diese Metakompetenzen fallen in die 
schon erwähnten digitalen Grundkompetenzen, welche ver- mittelt werden sollen. Mit Hilfe von Ma-
king kann das auf eine sinnstiftende und kreative Weise erfolgen. Daraus kann geschlossen werden, 
dass das passive Konsumieren der Vergangenheit angehört und das aktive Machen auch im Schul-
wesen gefördert werden sollte. 

Making ist daher ein demokratisierendes und emanzipierendes Mittel.
 
Seit dem Ende der 2000er Jahre begannen Forscher*innen und Pädagog*innen FabLabs für Unter-
richtszwecke einzusetzen. Beispielsweise startete die renommierte Stanford Universität das FabLab@
School-Projekt bei dem es FabLabs in sogenannten K-12 Schulen auf der ganzen Welt initiierte. 2011 
startete Maker Media ein MakerSpace Projekt mit einem DARPA (Defense Advanced Research Projects 
Agency, an US military research agency) Sponsoring. In den folgenden Jahren schlossen sich zahlrei-
che Museen, Schulen, Community Centers und Büchereien diesem Trend an (Blikstein, 2013, S. 206) 
 
Auch in Österreich entstehen immer mehr Makerspaces. In größeren Städten jedes Bundes-
landes wächst deren Anzahl stetig (Kneuer). Außerdem entstehen auch immer mehr aka-
demische Makerspaces. 2019 eröffnete eine Hightech-Werkstatt der TU Graz und gilt so-
mit als größter akademischer Makerspace in Österreich (Labor für Innovation, 2019). 
Hierin kann auch gesehen werden, dass die Wirtschaft ein Potential erkannt hat, und versucht 
sich, diese Räume zu eigen zu machen. Dies steht allerdings in Kontrast zur ursprünglichen Idee. 
Obwohl auch manche HTLs ihre Schule öffnen und so den Zugang zu den Werkzeugen und Maschi-
nen erleichtern (Donnerbauer, 2019), gibt es immer noch zu wenig Initiativen um an Schulen kleine 
Makerspaces einzurichten. Die Ausstattung mit Single-Board Platinen, Lötkolben, elektronischen 
Bauteilen und Bastelmaterial würde dafür schon ausreichen. 

Blikstein, P. (2013). Digital Fabrication and ’Making’ in Education. In J. Walter-Herrmann & C. Büching (Hrsg.), Fablab: Of ma-
chines, makers and inventors (S. 203-222). Bielefeld: transcript Verlag.

Dittert, N. & Krannich, D. (2013). Digital Fabrication in Educational Contexts: Ideas for a constructionist workshop setting. In J. 
Walter-Herrmann & C. Büching (Hrsg.), Fablab: Of machines, makers and inventors (S. 173-180). Bielefeld: transcript Verlag.

iMoox.at. (2019, März). [lul1] Von Lerntheorien zum didaktischen Design. Zugriff am 15. August 2019 auf https://www.youtube.
com/watch?v=7Em7bq7wLVg&feature=youtu.be

Donnerbauer, S. (2019, Januar). Zugriff am 15. August 2019 auf https://www.noen.at/hollabrunn/ neuer-maker-space-htl-hol-
labrunn-baut-offene-werkstatt-fuer-alle-hollabrunn-htl -hollabrunn-133867044#

Katterfeldt, E.-S., Zeising, A. & Lund, M. (2013). Notes on Maker Culture. In J. Walter-Herrmann & C. Büching (Hrsg.), Fablab: 
Of machines, makers and inventors (S. 123-126). Bielefeld: transcript Verlag.

Kneuer, M. (o. J.). Makerspaces in Österreich. Zugriff am 15. August 2019 auf http://www.makerszene .at/makerspaces-in-oe-
terreich/

Labor für Innovation: Hightech-Werkstatt eröffnet an TU Graz. (2019, April). Zugriff auf https://science.apa.at/dossier/Labor_
fuer_Innovation_Hightech-Werkstatt_eroeffnet _an_TU_Graz/SCI_20190425_SCI83015586848148774
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Elektronik 101

Strom
(current)

Widerstand
(resistance)

Spannung
(voltage)

Elektrizität ist die Bewegung von 
Elektronen. Elektronen erzeugen 
Ladung, die wir für uns arbeiten las-
sen können. Eine Glühbirne, das 
Smartphone, der Fernseher, ... alles 
zapft Strom ab, um arbeiten zu kön-
nen. 

Formelbuchstabe:
Einheitszeichen:

U
V Volt

Formelbuchstabe:
Einheitszeichen:

I
A Ampere

Formelbuchstabe:
Einheitszeichen:

 R
Ω  Ohm

Dadurch, dass Elektrizität vom Menschen nicht gesehen werden kann, wird das Prinzip der Elekt-
rizität oftmals mit einem Wassertank mit angeschlossenem Schlauch verglichen.
Dabei entspricht

die Wassermenge = Ladung
der Wasserfluss = Strom
der Wasserdruck = Spannung
der Schlauchdurchmesser = Widerstand

Der Druck am unteren Ende des Tanks entspricht der Spannung. Das Wasser entspricht der La-
dung. Je mehr Wasser im Tank ist, desto höher ist die Ladung und der Druck, also die Spannung 
am unteren Ende des Tanks.
Der Tank gleicht dabei einem Akku bzw. einer Batterie. Wenn wir quasi den Wasserschlauch auf-

drehen, dann geht Wasser verloren, das heißt die Spannung wird weniger. Auch 
bei einer Taschenlampe wird die Leuchtkraft immer schwächer, sobald die Batte-
rien leer werden. Weniger Druck bedeutet auch, dass weniger Wasser fließt. Der 
Wasserfluss kann mit dem Strom verglichen werden. Je höher der Druck, desto 
höher der Wasserfluss und umgekehrt. 
Wenn man nun den Schlauch an einer Stelle zusammendrückt, dann fließt weni-
ger Wasser hindurch. Diese Funktion des Regelns des Stromflusses übernimmt 
der Widerstand.

WiderstandSpannung

Ohm’s Law
zeigt den Zusammenhang der 
drei Größen und wie sie sich 
errechnen lassen

U = I x R
R = U / I
I  = U / R

das elektrische Potential zwischen 
zwei Punkten in einem Schaltkreis

die Elektronen, die sich durch 
den Leiter bewegen

ein Mittel, dass den Stromfluss 
reduziert
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Elektronik 101
Strom messen

Widerstand messen

Spannung messen

Die Messleitungen müssen in die beiden Buchsen 
gesteckt werden. 
• das rote Kabel in die rote Buchse, die mit 

VΩmA (Widerstands- und Spannungsmes-
sung) oder 10A (Strommessung)

• das schwarze Kabel in die schwarze Buch-
se, die COM heißt. COM steht dabei für “com-
mons” und bedeutet soviel wie “gemeinsam”

Die Elektronen wandern von 
einem Pol zum anderen. Die 
Spannung und Bewegungs-
richtung der Elektronen ändert 
sich nicht, alles bleibt gleich

Abkürzung: 
DC (Direct Current)

Bei Wechselspannung ändert 
sich die Flussrichtung der Elek-
tronen ständig. 

Abkürzung: 
AC (Alternating Current)

Gleichspannung vs. Wechselspannung

1. das rote Messkabel an VΩmA anschließen
2. den Drehregler auf einen Wert von V stellen
3. das rote Kabel an den Pluspol halten und das schwarze an
    den Minuspol einer Batterie

Damit der Strom gemessen werden 
kann, muss das Multimeter Teil des 
Stromkreises werden. Daher muss 
es in Reihe mit der zu prüfenden 
Komponente geschalten werden. 
1. das rote Messkabel an 10A an-
    schließen
2. den Drehregler auf einen Wert
    von A stellen

das Multimeter

1. das rote Messkabel an VΩmA anschließen
2. den Drehregler auf einen Wert von Ω stellen
3. das rote und schwarze Kabel links und rechts vom Wider-
    stand anlegen

Starte mit der niedrigsten Einheit, 
sollte es eine 1 anzeigen, heißt das 
der Wert ist größer als die Anzeige 
darstellen kann,
dann muss einfach auf den nächsten 
Anzeigebereich gestellt werden.
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1Das Steckbrett oder Steckplatine wird im Engli-
schen als Breadboard bezeichnet. Es dient dazu, 
Schaltungen aufzubauen und zu testen. Die Bau-
teile können dabei jederzeit umgesteckt werden. 
Die Steckplätze sind untereinander verbunden 
und zwar so, wie auf der Abbildung gezeigt wird. 
Wenn das Brett waagrecht vor einem liegt, ist in 
der Mitte eine waagrecht verlaufende Vertiefung 
zu erkennen. Die Kontakte darüber und darunter 
sind senkrecht miteinander verbunden. Die oben und unten verlaufenden Leisten am Board be-
sitzen ebenfalls eine Verbindung zueinander. Manchmal gibt es auch eine zweite parallel verlau-
fende Reihe. Dabei sind die Löcher nur mit den Nachbarn nebeneinander verbunden. Die beiden 
Reihen sind nicht miteinander verbunden. Normalerweise werden sie verwendet um das Board 
mit Strom zu versorgen und mit Plus und Minus einer Batterie oder des Arduinos zu verbinden. 

Steckbrett
(breadboard)

Schaltkreis
(circuit)

Parallelschaltung

Serienschaltung

Eine Batterie oder Steckdose hat eine bestimmte Anzahl an Volt – so wird die elektrische Span-
nung angegeben. 
Damit wir Strom benutzen können, muss er im Stande sein, sich zu bewegen. Strom kann nur 
durch leitfähige Materialien fließen.
Strom fließt immer von einer Spannung zur anderen, wenn man also einen leitfähgien Pfad zwi-
schen einer hohen und niedrigeren Spannungsquelle herstellt, wird der Strom durchfließen. Be-
findet sich entlang dieses Pfades etwas Nützliches wie beispielsweise eine LED, dann wird diese 
aufleuchten. 
Jede Stromquelle hat zwei Seiten: + und –. 
Zwei Bauteile können auf zwei Arten miteinander verbunden werden:

Etwas in Serie oder in Reihe zu schalten bedeutet, 
die Bauteile werden nacheinander angereiht.

Bei der Parallelschaltung werden die Bauteile 
nebeneinander und unabhängig voneinander ge-
schaltet. 

Eine Standard LED hat einen Durchmesser von 5 
mm. Normalerweise beginnt sie bei 8 – 12 mA zu 
leuchten, erhöht man den Strom leuchtet sie heller. 
Im Datenblatt kann man nachlesen wie viel Strom 
die LED maximal verträgt – normalerweise 20 mA 
(wobei der Unterschied zu 15 mA nur minimal ist). 
Auch die Durchflussspannung UF ist im Daten-
blatt nachzulesen. Bei der Widerstandsbstimmung 
muss die Durchflussspannung berücksichtigt wer-
den (dh vom Gesamtstrom abgezogen werden). 

Berechnung des Widerstandes für eine LED
Stromquelle: 9 V Batterie
gewünschter Betriebsstrom: 18 mA (laut Datenblatt)
Durchflussspannung: 1,8 V (laut Datenblatt)

R = U / I => U = 9 V – 1,8 V = 7,2 V
R = 7,2 / 0,018 = 400 Ohm
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Elektronische Bauteile

Widerstand
(resistance)

BASICS

KONNEKTIVITÄT IR
(infrared sensor)

Bluetooth Module
(low energy)

Der Transistor ist das grundlegende Bauele-
ment aller elektronischen Elemente. Er hat im 
Wesentlichen zwei Aufgaben: Verstärken und 
Schalten!

Transistor

Der Widerstand sorgt dafür, 
den Strom zu reduzieren, da-
mit empfindlichere Bauteile 
nicht beschädigt werden. Es ist 
egal, wie der Widerstand einge-
baut wird. Die farbigen Streifen 
sind ein Code, mit dem man er-
rechnen kann, um welche Stär-
ke es sich handelt.

Elektronik 101

Farbe 1. Ring 2. Ring Multiplikator Toleranz
farblos - - - 20 %

silber - - - 10 %

gold - - 5 %
schwarz - 0 - -

braun 1 1 0 1 %
rot 2 2 00 2 %
orange 3 3 000 -
gelb 4 4 0.000 -

grün 5 5 00.000 0,5 %
blau 6 6 000.000 0,25 %
violett 7 7 0.000.000 0,1 %
grau 8 8 00.000.000 0,05 %
weiß 9 9 000.000.000 -

Beispiel: Braun – Orange – Braun => 1 – 3 – 0 = 130 Ohm
                 (silber oder gold sollte immer rechts stehen)

Diode

Kondensatoren haben 
die Fähigkeit, Energie in 
Form von Spannung für 
kurze Zeit zu speichern. 
Es gibt viele verschiedene 
Arten von Kondensatoren 
(Keramik, Aluminium, ...)

Kondensator
(capacitor)

Elektrischer Strom kann 
eine Diode nur in eine 
Richtung passieren

Kroko Klemmen
(crocodile wire)

Jumper
(jump wire)
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LED - Light Emitting Diode

Stepper-Motor

Fotowiderstand
(photoresistor)

INPUT
(Sensoren)

MOTOR

OUTPUT
(zB Aktoren, LEDs)

Wasserstand
(water level)

Piezo-Lautsprecher

Servo-Motor

DC-Motor

Temperatur und Luftfeuchtigkeit
(temperature and humidity)
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1

Taster
(button)

Anode
+ 

lang
Kathode

–
kurz

Ultraschall
(ultrasonic sensor)



Programmier-Basics

Was ist eine Variabe?

Eine Variable ist eine Art Platzhalter, der verschiedene Werte annehmen kann. 
Zunächst muss eine Variable deklariert werden. Das bedeutet man sagt dem Programm “Hey, es gibt 
hier eine Variable, die heißt ‘soundso’ und besitzt Zahlen (oder etwas anderes) als Werte”. Man schreibt 
dazu beispielsweise folgendes:

int x;

Nun hat man dem Programm gesagt, es gibt eine Variable mit Namen x, die Integer-Werte, also ganze 
Zahlen enthält, das heißt sie ist vom Typ Integer. Noch ist diese Variable leer, das heißt sie hat keinen 
Inhalt, aber das Programm hat Speicherplatz dafür bereit gelegt. Mit dem "=" Zeichen kann der Variable 
nun ein Inhalt zugewiesen werden: x = 2; 
 
Es gibt eine handvoll primitiver Datentypen.

Mit der if-Bedingung können bestimmte Programmteile selektiv ausge-
führt werden. 

Die Bedingung ist ein Bool’scher Ausdruck. Wenn die Bedingung wahr 
ist, dann wird die Anweisung ausgeführt, sonst wird sie übergangen. 

Die Ziele von if und else sind einzelne Anweisungen 
oder Anweisungsblöcke. Die else-Klausel ist optional.
Hat die Bedingung des Ausdrucks den Wert true, wird 
der Anweisungsblock von if ausgeführt, andernfalls 
wird, falls vorhanden, der Anweisungsblock von else 
ausgeführt. Beide werden niemals gleichzeitig ausge-
führt. Als verschachtelte if-Bedingung wird sie dann 
bezeichnet, wenn nach dem else gleich wieder ein if 
kommt.

Operatoren
< kleiner als
<= kleiner als oder gleich
> größer als
>= größer als oder gleich
== gleich
!= ungleich
&& UND
|| ODER

if ( Bedingung ) {
 Anweisung;
} else {
 Anweisung;
}

Was ist ein if-Statement (Bedingung)?

Typ Beschreibung Wertebereich Bits
byte

ganze Zahlen

-128 .. 127 8
short -32768 .. 32767 16
int -2147483648 .. 2147483647 32

long -9223372036854775808 .. 
9223372036854775807 64

float
Gleitkommazahlen

einfache Genauigkeit 32
double doppelte Genauigkeit 64
boolean kann 2 Zustände annehmen true und false, 1 und 0 8

char Zeichen, Buchstaben, Uni-
code 0 .. 65.536 16

Program
m

ier-Basics

https://www.arduino.cc/reference/en/
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Was ist ein Loop (Schleife)?
Mit einer Schleife kann Programmcode wiederholt ausge-
führt werden. Am häufigsten werden while-Schleifen und 
for-Schleifen verwendet.

for (Initialisierung; Bedingung; Iteration) {
      Anweisung;
}

for ( int x; x < 100; x++ ) {
      Serial.println(x);
}

while (Bedingung) {
      Anweisung;
}

int x;
while ( x < 100 ) {
      Serial.println(x);
      x++;
}

In der allgemeinen Form wird bei der Initialisierung der 
Schleife eine Steuervariable auf ihren Anfangswert ge-
setzt. 

Die Bedingung ist ein Boole’scher Ausdruck, der die Steu-
ervariable testet. Liefert das Ergebnis des Tests den Wert 
true, wird die for-Schleife weiter durchlaufen. Hat das Er-
gebnis den Wert false, wird sie beendet. 

Der Iterationsausdruck legt fest, wie die Kontrollvariable 
bei jedem Schleifendurchlauf verändert wird.

Eine While-Schleife wird solange wiederholt 
ausgeführt bis die Bedingung nicht mehr 
wahr ist.

Wird also im Anweisungsblock keine Ope-
ration gesetzt, die die Bedingungsvariable 
verändert, handelt es sich um eine Endlos-
schleife.

Pr
og

ra
m

m
ie

r-
Ba
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Inkrement
count = count + 1;

entspricht
count++;

dasselbe funktioniert auch mit 
Minus
count -- zählt also hinunter
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Methoden, sind wiederverwendbare Programm-
stücke und werden manchmal auch als "Unterrou-
tinen" oder "Unterprogramm" bezeichnet.

Sie sind prinzipiell dazu da den Code leserlicher 
zu machen und Redundanzen (Wiederholun-
gen) zu vermeiden. Ein Stück Code, dass immer 
wieder verwendet werden soll, ist am besten in 
einer Methode aufgehoben. Natürlich kann man 
oftverwendete Programmierzeilen immer wieder 

Allgemeine Form:

ret-Typ Name (Parameterliste) {
//Methodenrumpf
}

Was ist eine Methode?

Der Name kann frei gewählt werden und wird prinzipiell klein geschrieben. Der ret-Typ (return Typ) 
ist der Rückgabewert. Und die Parameterliste ist eine Aufzählung an Variablen, die mit einem Kom-
ma getrennt werden. Sie wird außerdem immer außerhalb des Hauptprogramms geschrieben, bei 
Arduino heißt das, außerhalb der loop(){...} Methode.
 
Wenn man selber eine Methode schreibt, überlegt man sich also, was die Methode tun soll und was 
man dazu benötigt. Möchte ich beispielsweise ein Methode schreiben zum Addieren zweier Inte-
ger-Werte, dann erwarte ich mir von demjenigen, der die Methode aufruft, dass er mir zwei Inte-
ger-Werte gibt und keine Strings oder booleans. Diese Werte nennt man Argumente oder Parameter 
und werden in der Parameterliste näher definiert. Außerdem möchte ich, dass die Methode die Sum-
me zurück gibt. Auch hier muss ich definieren von welchem Typ der Rückgabewert ist. Die Methode 
würde beispielsweise so aussehen:

In dieser Methode ist das erste int der Rückgabewert. Sobald ich hier einen Wert stehen habe, 
muss ich return und eine Variable von diesem Typ angeben. Sobald return aufgerufen wird, endet 
die Methode, alles was danach steht wird nicht mehr ausgeführt.
Der Name add2integers ist frei gewählt. Die Parameterliste deklariert zwei Variablen, die nur in die-
ser Methode bekannt sind. Sie werden anschließend addiert und der Variable sum zugewiesen.
 
Um die Methode im Hauptprogramm aufzurufen, wird der Name der Methode geschrieben und, falls 
vorhanden, Parameter angegeben.

int add2integers(int x, int y){
 int sum;
 sum = x + y;
 return sum;
}

int number1 = 10;
int number2 = 20;
int sum = add2integers(number1, number2);

mit Copy & Paste einfügen, doch dass führt zu 
langem, schwer leserlichen Code und es ist auf 
Dauer mühsam immer wieder ein Codestück raus-
zusuchen, zu kopieren und einzufügen.

Wenn eine Methode keinen Rückgabewert besitzt, so wird 
dafür der Begriff void als ret-Wert verwendet. 

Program
m

ier-Basics
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Arduino

USB Anschluss

Reset Knopf

Digitale Ein- und Ausgänge
0 -13GND = Ground

Power On LED

Mikrocontroller

Analoge Eingänge
A0-A5

Externe Stromversorgung
6-20  V empfohlen 7-12 V

3,3  V Pin

5 V Pin

GND = Ground
Spannungsversorgung

per Pin

O ... RX ... Receive
1 ... TX ... Transmit
für Übertragungen zB Bluetooth
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PIN 13 verfügt über einen 
Vorwiderstand, dh hier kann 
jederzeit eine LED angebracht 
werden, ohne Angst haben 
zu müssen, dass diese 
durchbrennt.

eine frei benutzbare und bearbeitbare Software oder Hardware, deren Ziel 
das gemeinschaftliche, freie Arbeiten und Weiterentwicklen von Dingen istOpen-Source

Elektronik

Prototyping

Plattform

Technologie, die sich die Bewegung von Elektronen durch leitfähiges 
Material zu Nutze macht

eine Grundform (Entwurf), die als Standard oder Vorlage für andere Dinge 
gilt 

eine Hardware-Architektur mit einer Entwicklungsumgebung, auf der 
Software laufen kann.

discrete & finite

true
1
on

HIGH

continous & infinite

false
0
off

LOW

0 .. ∞

binär Wertebereich
DIGITAL          vs.         ANALOG
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Verbinde das Arduino Board mit 
der IDE

Arduino IDE

Um den Arduino zu programmieren, wird eine 
Software – die Entwicklungsumgebung IDE – 
benötigt.

Öffne deinen ersten Sketch unter 
File > New
Als Sketch werden die Programme auf dem Arduino bezeichnet.

Verifiziert den Sketch

Serial Monitor

Lädt den Sketch auf den 
Arduino Öffnet einen Sketch

Speichert einen SketchNeuer Sketch

Text Editor

zeigt verschiedene  
Mitteilungen an
=> ein Fehler im  
     Programmcode
=> erfolgreich durchgeführter
     Upload

Terminal

die zwei vorgegebenen 
Funktionen

setup() und loop()

wird 1x zum 
Programmstart 

ausgeführt
wird immer 

wieder  
wiederholt

überprüft das 
Programm auf 

Fehler

Wähle den richtigen Port aus

Tools > Board > Arduino

Tools > Port > usbmodem (Arduino)

Diese ist gratis downloadbar unter
https://www.arduino.cc/en/Main/SoftwareArduino
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Serial Monitor
Der serielle Monitor muss in der setup() Funktion mit Serial.begin(9600) 
gestartet werden.
9600 gibt dabei die Frequenz an – bits per seconds (Baudrate)
Serial.print();
Serial.println();
geben dann Text (unter Anführungszeichen) oder Variablen aus. 
Beides kann auch durch ein + verbunden werden:

Serial.println(“Text unter Anführungszeichen “ + variablenName);

Libraries
Es gibt eine riesige Arduino Community, die auch eigene Libraries schreibt. 
Eine Library – ein Bibliothek – bietet schon jede Menge fertiger Funktionen 
und Programmteile. Sie erleichtern die Programmierung mit Arduino unge-
mein.
Eingebunden wird eine Lib über: 

Sketch > Include Library > Manage Libraries
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Arduino Beispiele

Bringe eine LED zum Leuchten!

Für das allererste Programm wird nur der Arduino und ein USB Kabel benötigt. Der Arduino wird an-
geschlossen und das Beispielprogramm wird geladen:  

File > Examples > 01.Basics > Blink

pinMode(pin, mode) => ob ein Pin als Input oder Output fungieren soll

digitalWrite(pin, value) => wenn der Pin als OUTPUT konfiguriert wurde über pinMode(), dann 
schaltet der Wert HIGH den Pin auf 5V (oder 3.3V bei 3.3V Boards) oder der Wert LOW auf 0V 
(ground) 

delay() bedeutet Verzögerung, der Wert 1000 ist in Millisekunden angegeben

Es kann zusätzlich eine LED bei Pin 13 angeschlossen werden, diese kann direkt in den Arduino ge-
steckt werden, das lange Beinchen (Plus) wird dabei in Pin 13 gesteckt und das kurze Beinchen (Minus) 
in den Ground Pin daneben. Das ist nur möglich, weil Pin 13 bereits über einen Vorstandswider-
stand verfügt. Wäre das nicht der Fall, würde das Lämpchen durchbrennen.

Arduino
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Teste den Piezo-Lautsprecher!

Der Piezo-Lautsprecher wird auch passive buzzer genannt und bietet die Möglichkeit, verschiedene 
Töne, Melodien und Sirenensignale zu generieren. 

Die Erzeugung des Tones basiert auf dem Befehl tone(x, y)
=> x-Wert gibt den Pin an, an dem der Lautsprecher angeschlossen ist 
=> y-Wert gibt die Tonhöhe an

Rufe das folgendes Beispielprogramm auf:
File > Examples > 02.Digital > toneMelody

VORSICHT: adaptiere den Pin, den du benutzt

Ar
du
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Teste den Wasserstandmesser!

Verbinde den Water Level Sensor mit 
dem Arduino und lasse die gemessenen 
Werte im Serial Monitor ausgeben. Merke 
dir dabei, welche Zahl bei der Hälfte des 
Sensors ausgegeben wird. 

Erweitere nun die Schaltung 
um einen Buzzer und lass 
immer dann einen Ton aus-
geben, wenn dieser Wert er-
reicht wird.
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Arduino

Teste die IR-Fernbedienung!

Infrarotstrahlung ist eine Form von Licht 
– allerdings können Menschen dieses 
nicht sehen, da es sich in ihrer Frequenz 
und Wellenlänge von dem für Menschen 
sichtbaren Licht unterscheidet. 
Da es sich also um eine Form von Licht 
handelt, benötigt der Empfänger und 
der Transmitter eine direkte Sichtverbin-
dung. 

Anders als bei IR benötigt Bluetooth und 
WiFi keine direkte Sichtverbindung und 
das Signal kann durch Wände und an-
dere Materialien hindurchgehen.

Lade dazu die Library
• IRremote
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Teste das Bluetooth Modul HC-08!

Das Bluetooth Modul HC-08 dient zur seriellen Kommunikation zwischen zwei bluetoothfähigen Gerä-
ten. Die Pins am Bluetooth Modul sind wie folgt belegt:

Du benötigst auf dem Smartphone ein Bluetooth Terminal:
• unter Android empfiehlt sich DSD Tech Bluetooth
• unter iOS empfiehlt sich HM10 Bluetooth Serial Lite

Ar
du

in
o

WICHTIG: 
• RX ist mit TX verbun-

den und TX mit RX
• beim Uploaden des 

Codes dürfen RX/TX 
und TX/RX nicht ver-
bunden sein 
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Arduino

Teste den Temperatur und Luftfeuchtigkeitssensor!

Verbinde den Sensor wie auf der Abbildung !

Lade dazu die beiden Libraries
• DHT sensor library
• Adafruit Unified Sensor (wird für DHT benötigt)

Erweitere die Schaltung mit dem Bluetooth Modul. 
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Steuere einen Servo-Motor an!

Servo-Motoren können sich im Normalfall 180° drehen. 
Erstelle eine Schaltung wie abgebildet.

Der Servo-Motor besitzt drei Anschlüsse: 
• Strom
• Erdung
• Daten

Lade das Beispielprogramm:

File > Examples > Servo > Sweep

Erweitere die Schaltung und den Code um einen zweiten Servo-Motor.
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Schere, Stein, Papier
Das Spiel "Schere, Stein, Papier" ist bei Kindern 
sehr beliebt. Was aber, wenn man niemanden zum 
Spielen findet? Dann kann man sich mit einem 
Arduino und zwei Servo-Motoren eine Roboterhand 
bauen.

Mache dich mit der Anatomie der menschlichen 
Hand vertraut.

Schneide die Grundform der Hand aus Karton oder 
der Leichtschaumplatte aus.

Fädle den Faden durch das 
Holzkügelchen und dannach durch 
die Strohhalme.

Schneide die Finger aus den 
Strohhalmen zurecht. Bedenke dabei, 
dass du sie auch an der Grundform 
anbringen musst, schneide sie also 
lang genug ab.

Schneide die Halme an den Stellen 
ein, wo sich die Finger abbiegen 
lassen.

1
2

3

4

5

9

• Arduino
• USB-Kabel
• 2 Servo-Motoren (oder 5 

falls jeder Finger anges-
teuert werden soll

• Jumper Kabel (mind. 8)

• Leichtschaumplatte oder 
Karton

• Strohhalme (mindestens 
8 mm Durchmesser)

• Holzkügelchen für jeden 
Finger

• Cutter und Schere
• Faden
• Nadel
• Heißklebepistole

Was wird benötigt?

Mache dich mit den Servo-Motoren 
vertraut. Hänge dazu einen Servo-
Motor an und lade das Beispiel

6

File > Examples > Servo > Sweep

Arduino
Überlege dir nun, wie viele Zustände eine Hand bei dem 
Spiel "Schere, Stein, Papier" besitzt.

7

8

Es braucht daher nur zwei Servo Motoren – 
einen, der Daumen, Ring- und den kleinen 
Finger steuert und einen, der Zeige- und 
Mittelfinger steuert.

Klebe mit Heißkleber die "Finger" 
an der "Hand" an.

Bereite die beiden Servo Motoren 
vor und verkabele diese wie auf dem 
Schaltplan beschrieben.

10

Papier alle Finger ausgestreckt
Schere zwei Finger ausgestreckt, drei Finger 

abgewinkelt
Stein alle Finger abgewinkelt

# RoboticHand #SchereSteinPapier
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Schreibe deinen eigenen 
Code wie in der Abbildung 
angegeben.

Lade den Code auf den Arduino.

11
12
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Arduino

Weather Station

Bau dir deine eigene Wetter Station. Entweder man benützt 
die Sensoren aus den Übungsbeispielen, oder wie in die-
sem Fall das Arduino Wetter Shield. Es beinhaltet Sensoren 
wie einen Lichtsensor, Feuchtigkeitssensor, Regenmelder, 
Bodenfeuchtigkeitssensor, Temperatur- und Drucksensor. 
Außerdem beinhaltet das Shield eine microSD-Karten Slot, 
so können die Daten direkt im CSV Format aufgenommen 
werden und mit einem Tabellenkalkulationsprogramm aus-
gelesen werden.

• Arduino
• Wetter Shield
• Box/alte Eisverpackung
• PC/Mac
• Schere/Messer
• Ladegerät
• microSD Karte

Was wird benötigt?

# WeatherStation

Laden den Example Codes:
File > Examples >  
Weather Station > Datalogger

Vorbereiten des Codes. 
Dazu werden folgende Lib-
raries verwendet:
• Weather Station
• Sparkfun BMP180
• SDFat

1

2

3

Da der Arduino nicht wasserdicht ist, muss eine 
Box gebaut werden. Auf den Abbildungen wurde 
dazu eine  alte Eisverpackung verwendet.

Nachdem man die Box ein paar Tage draußen gelas-
sen hat, können die Daten der SD-Karte ausgelesen 
werden.

Überlege dir ruhig, wie das Projekt erweitert werden 
kann. Zum Beispiel könnte man ein Bluetooth Modul 
hinzufügen, um die Daten so kabellos zu übertragen.

►https://www.instructables.com/id/Ardui-
no-Weather-Station-1/
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LilyPad

Li
ly

Pa
d

TX

Analoge Ein- und Ausgänge
A0 - A5

Reset Button

RX

IC Unit

Im Grunde genommen ist das LilyPad nichts anderes als 
ein Arduino in einer kreisrunden Bauform.  Die Löcher der 
Pins sind etwas größer und dafür ausgelegt, dass sie mit 
leitfähigem Garn angenäht werden können. Es wurde au-
ßerdem darauf geachtet, dass alle Komponenten sehr flach 
angeordnet sind, um beim Tragen nicht stören. 

Der Hersteller gibt an, dass er nicht dafür haftet, wenn man 
es wäscht, allerdings gibt dieser schon an, es zu waschen.
Einen Kompromiss bieten daher auch andere Varianten, 
wie zum Beispiel das LilyPad Arduino Simple Snap, das mit 
Druckknöpfen befestigt und auch wieder entfernt werden 
kann. Außerdem hat diese Variante bereits einen LiPo-Ak-
ku eingebaut. 

Das LilyPad bietet außerdem noch eine Vielzahl an weite-
ren Bauteilen wie LEDs, Sensoren, Battery Clip, etc. Sie 
haben den Vorteil, dass sie sehr flach verarbeitet sind und 
meistens schon einen Vorwiderstand integriert haben. Man 
muss daher nicht mühsam berechnen, welche Bauteile 
man noch benötigt.

Ground

5V

Ein- und Ausgänge
5 - 13

Ein- und Ausgänge
2 - 4

Alternativen:

Adafruit Flora
Arduino Gemma

beide sind ebenfalls kreisrund an-
geordnet und für den Entwurf von 
Wearables ausgerichtet, wobei 
das Gemma etwas kleiner und 
leistungsschwächer ist.

FTDI

Das LilyPad verfügt über kei-
nen USB Port, sondern FTDI 
Pins! Daher empfiehlt es sich 
einen FTDI-USB Adapter zu 
kaufen.

Achtung – es muss dieser Treiber 
installiert werden:

► http://www.ftdichip.
com/Drivers/VCP.htm

Flora Gemma

Status 
LED
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LilyPad

Tipps für Wearables

1

Wearables, eFashion, Smart-
Fashion, E-Textiles sind sehr 
ähnliche Begriffe, die mit trag-
barer Elektronik in Verbindung 
gebracht werden.

Textile Leiterbahnen aufbringen durch ...
leitfähigen Stoff aufnähen 

leitfähiges Garn aufnähen

Leiterbahn mit Spinnvlies aufbügeln

Leiterbahn aufkleben

Leiterbahn isolieren mit Nagellack, Textilkleber oder  durch Einnähen von Textil oder Garn2
Mache das LilyPad abnehmbar, indem du Druckknöpfe anlötest. Da Druckknöpfe leiten, 
können die Ports immer noch verwendet werden.3

Elektronische Schaltkreise 
müssen nicht immer gelötet 
werden, sie können genauso-
gut mit leitfähigem Stoff oder 
Garn realisiert werden.

eFashion

Suche dir ein geeignetes Kleidungsstück – am 
besten einen Schal, Schuhe oder eine Handta-
sche.

Überlege dir, was du machen möchtest:
• Willst du einfach nur LEDs anbringen, sollen diese abwechselnd 

leuchten oder alle durchgehend? 
• Sollen diese durch einen Sensor aktiviert werden?
• Soll es vibrieren?

Bedenke, dass nicht alle elektronischen Komponenten in der 
Waschmaschine gewaschen werden können. Die LilyPad LEDs 
können ohne Probleme gewaschen werden, allerdings sollte das 
LilyPad selbst abnehmbar sein. 
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Die Ampli-Tie ist eine Krawatte, die ausschlägt, wenn je-
mand mit dir spricht. Sie verhält sich also wie ein VU-Meter 
und ist dabei ein richiger Hingucker!

Ampli-Tie
• Flora/LilyPad
• 16 Flora NeoPixels
• PC/Mac
• Mikrofon Amplifier  

Breakout
• 100mAh LiPoly Akku
• Kabel/Jumper
• 
• leitfähiges Garn
• Krawatte
• Stoff für Akku-Tasche
• Nadel oder Nähmaschine
• Schere

Was wird benötigt?
by Becky Stern

►https://learn.adafruit.com/led-ampli-tie

#Ampli-Tie

Die NeoPixels wer-
den miteinander an 
die Erdung und an 
VBATT angeschlos-
sen. Der Datenkanal 
wird an D6 ange-
schlossen, während 
das Mikrofon an 3.3 
V, GND und D9 ge-
legt wird.

1

2

3

Für den Akku wird auf der Rückseite der 
Krawatte eine kleine Tasche aus Stoff ge-
fertigt

Danach werden die 16 NeoPixels aufgenäht. 
Achte dabei, dass die NeoPixels richtig ausge-
richtet sind. Teste mit dem Multimeter nach je-
dem NeoPixel immer, ob sie noch funktionieren. 
Der Stromkanal und Erdung dürfen sich nicht be-
rühren.

Das Mikrofon kann mit schwar-
zen Nagelack lackiert werden um 
zur Krawatte zu passen.

Für das Projekt wird 
die NeoPixel Library 
"Adafruit_Neoixel" be-
nötigt. Diese wird üb-
licherweise über den 
Library Manager ge-
funden.Der Projekt-Code ist verfügbar unter: 

https://learn.adafruit.com/led-ampli-tie/the-code

4

5

6
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LilyPad

Sonic Sound Scarf

Suche dir einen geeigneten Stoff 
für den Schal. Ein Schlauchschal, 
auch Snood genannt, ist sehr ein-
fach selbst zu machen. Der Stoff 
wird später einmal in der Mitte ge-
faltet und zusammengenäht.

1

Der Sonic Sound Scarf ist ein Schlauchschal, der 
Musik abspielen kann. 

by Stephanie Mars
►https://www.instructables.com/id/Make-
your-own-sonic-sound-scarf/

• LilyPad MP3 Player
• MicroSD Karte
• ev SD Karten Adapter
• PC/Mac
• 2x Speaker
• leitfähiges Garn
• Li-Ion Akku
• Stoff
• Nadel oder Nähmaschine

Was wird benötigt?

Schneide zwei Stücke aus dem 
Stoff aus – eines wird der inne-
re und eines der äußere  Teil 
des Schals sein. Der äußere 
Teil sollte dabei etwas größer 
sein als der innere. Die Größe 
kann selbst ausgesucht wer-
den, empfohlen ist beispiels-
weise 100cm x 150cm, damit er 
zweimal umgewickelt werden 
kann.

2

3

Zeichne mit strichlierter Linie ein, 
wo dein leitfähiger Faden verlau-
fen soll und an welchen Stellen die 
Komponenten sitzen sollen. Die 
Lautsprecher sollten dabei an ei-
ner Stelle sein, die nahe am Ohr 
liegen.

►http://www.cottonandcurls.
com/2012/11/diy-infinity-or-circle-scarf-
tutorial-aka-the-snood/

Anleitung DIY Snood

# SonicSoundScarf
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In diesem Beispiel wird eine von drei Dateien abgespielt, 
wenn der längerer diamantförmige Teil eine der drei drei-
eckigen Formen berührt.

CC Sparkfun

4

5

Nähe nun das Lilypad an und gestal-
te eventuell eine kleine Tasche für den 
Akku und die Lautsprecher. 

Das LilyPad MP3 kommt mit allen nötigen Pins, so ist keine  
bis nur wenig Programmierung nötig. Außerdem hat es die 
Software "Trigger" vorinstalliert, die es erlaubt, bestimmte 
Dateien abzuspielen, wenn die Input Pins geerdet werden. 
Wem das nicht ausreicht, kann die "Player" Software runter-
laden und zusätzliche Funktionen einprogrammieren.

Li
ly

Pa
d



LilyPad

Überlege dir, welche Art von Arm-
band du möchtest!
Schneide entweder ein Stück Stoff 
zu recht oder Glieder einer stoffe-
nen Kette wie in der Abbildung.

1

Wer kennt das nicht – man sitzt den ganzen Tag in der 
Schule, im Büro oder vor dem Fernseher. Da kann man 
schon mal vergessen, aufzustehen. Das Beweg-Dich-Arm-
band vibriert alle halbe Stunde und erinnert dich so, etwas 
Bewegung zu machen.

Beweg-Dich-Armband
• LilyPad oder Gemma
• Vibrierender Mini Motor 
• PC/Mac
• 1N4001 Diode
• PN2222 NPN Transistor
• 200-1K Ohm Widerstand
• 100mAh LiPoly Akku
• Schrumpfschlauch
• ev LEDs/NeoPixels
• 
• leitfähiges Garn
• Stoff
• Nadel oder Nähmaschine
• Schere
• Druckknöpfe + Gerät

Was wird benötigt?
 by Becky Stern

►https://learn.adafruit.com/buzzing-mindful-
ness-bracelet

Der Projekt-Code ist verfügbar unter: 
https://learn.adafruit.com/buzzing-mindfulness-bracelet/code

Die Schaltung kann einfach eingenäht 
werden oder in die Glieder der Kette 
eingearbeitet. Die zweite Version ist et-
was kniffeliger. 

#BewegDichArmband

2

3

Auf dem Armband können nach Belieben NeoPixels angebracht werden.4



Makey Makey
Während Arduino und Ras-
pberry Pi etwas mehr tech-
nisches Hintergrundwissen 
voraussetzen, ist die Hand-
habung eines Makey Makey 
etwas einfacher. Jeder, der 
weiß, wie man einen elektro-
nischen Schaltkreis schließt, 
kann mit einem Makey Makey 
umgehen.

Erdung
(Ground)

Maus Belegung
Tastenbelegung

W,A,S,D,F,G

Obwohl das Makey Makey 
ziemlich selbsterklärend ist, 
hier ein kleiner Überblick.

Tastenbelegung
Pfeiltasten Leertaste Mausklick

Ke
y O

ut
M

au
s O

ut
Re

se
t

5V PG
CEr
du

ng

Mini USB

M
ak

ey
 M

ak
eyDas Makey Makey ersetzt im 

Wesentlichen ein Eingabe-
gerät wie eine Tastatur oder 
Maus.

Key Out und Maus Out sind 
mit Strom versorgt, sobald ein 
Schaltkreis geformt wurde

Mikrocontroller
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Do-It-Yourself-Surgery

Lese dir die Spieleanleitung des Originalspiels im Internet 
durch

Überlege was man alles braucht, wenn man 
das Spiel selber herstellen möchte

Finde ein passendes Bild über den mensch-
lichen Körper im Internet, drucke es aus und 
klebe es auf eine Schachtel

Schneide vorsichtig die wichtigsten Organe aus, achte dabei 
darauf, dass die Organe etwas kleiner als die Löcher sind (ge-
gebenenfalls kann das Bild auch noch in verkleinerter Form 
ausgedruckt werden)

Umrande die Organe, die Löcher und die Essstäbchen mit Alufolie

Gestalte Aufgabenkärtchen – schreib darauf, welches 
Organ entfernt werden soll und welche Aufgabe es im 
menschlichen Körper hat

M
akey M

akey

• Makey Makey
• Schachtel
• Kroko Klemmen oder 

Jumper Kabel 
• Alufolie
• Piezolautsprecher
• LED
• Essstäbchen
• Karton
• Schere
• eventuell Bildbearbeitung-

sprogramm

Was wird benötigt?

1
2

3

4

5

6

Das Operationsspiel ist ein 
beliebtes Kinderspiel – es ist 
aber auch ganz einfach, es 
selbst zu basteln.
Also Do It Yourself – DIY

Verbinde die Löcher mit dem Makey Makey. Dazu kann die Alufolie 
benutzt werden

LED und Piezo kann an den Key Out Pin 
angelegt werden

7
8

#DIY-Surgery
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Blackout Poetry
by Colleen Graves

Colleen Graves verwendet 
Makey Makey im Englisch-Un-
terricht und bezieht sich dabei 
auf David Saunders. Vor allem 
im Sprachunterricht ist es oft 
eine Herausforderung, Ju-
gendliche für Poesie zu inter-
essieren. 

Finde ein spannendes Gedicht (aus dem Internet ausgedruckt oder aus 
einem Buch)

Suche 10 oder mehr Worte, die du interessant findest und übermale 
alle anderen Stellen des Absatzes mit einem Graphitstift. Diese Worte 
und Wortgruppen ergeben nun ein neues Gedicht 

Um das Gedicht nun interaktiv zu gestalten, nimmst du die einzelnen 
Wörter und Wortgruppen in Scratch auf 

Lerne das Makey Makey kennen Lerne Scratch kennen

Verbinde Makey Makey mit Scratch und verbinde nun mit Hilfe des  
Graphitstifts die Gedichtpassagen mit Makey Makey 

M
ak

ey
 M
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ey

1
2

3 4

5

6

• Makey Makey
• PC/Mac mit Scratch
• Gedicht (Internet, aus 

Büchern, etc)
• Graphitstifte
• Kroko Klemmen oder 

Jumper Kabel

Was wird benötigt?

► https://colleengraves.org/2017/03/24/resource-interactive-blackoutpoetry-with-
makey-makey-and-scratch/

#BlackoutPoetry
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eInstruments

Überlege dir ein Instrument und schneide die Form aus 
Karton aus

Überlege dir, an welchen Stellen die Tasten sein 
könnten, beklebe diese Stellen mit Alufolie

Verbinde die Tasten mit dem Makey Makey

Spiele ein Lied mit dem Instrument und nimm es mit der Handykamera 
auf

Mische verschiedene Instrument-Aufnahmen am PC/Mac mit einer ent-
sprechenden Software zusammen

Überlege, welches Programm am besten für die Tastenbelegung mit 
verschiedenen Tönen geeignet ist. Recherchiere dazu auf: 

• Makey Makey
• Schachtel, Karton
• Kroko Klemmen oder 

Jumper Kabel 
• Alufolie
• PC/Mac mit Scratch
• sonstiges Bastelmaterial
• optional Smartphone zum 

Dokumentieren und Re-
mixen der Aufnahmen

Was wird benötigt?

2

3
4

5
6

Gestalte dein eigenes Musikinstrument 
mit Hilfe von Makey Makey.

1

► https://makeymakey.com/apps/

https://twitter.com/1001011k/status/635395999696072705
Xylophon von Digital K

http://www.wired.com/2015/05/19-gizmo-turns-anything-
touchpad/

M
akey M

akey

#eInstruments
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Sprechende Gemälde

Wähle ein ansprechendes Gemälde und drucke es aus

Mach dir zu folgenden Punkten Überlegungen:
• wann wurde das Bild gemalt
• wer hat das Bild gemalt
• was zeigt das Bild
• überlege dir eine Geschichte
• überlege dir Hintergrundinformationen zu den Personen auf dem Bild
• was fällt besonders auf

Befestige Reißzwecken im Bild 

Spreche mit Hilfe von Scratch Stichwörter, Teile einer Geschichte oder 
Informationen zu den einzelnen Teilen des Bildes ein

Verbinde die Reißzwecken auf der Rückseite mit dem Makey Makey

• Makey Makey
• Abbildungen von 

bekannten Gemälden
• Karton, Schachteln
• Reißzwecken
• Alufolie
• Kroko Klemmen
• Schere
• Kleber
• PC/Mac mit Scratch

Was wird benötigt?

2

3
4

5

Jedes Gemälde erzählt eine Geschichte. Belebe dein 
Lieblingsgemälde mit Makey Makey und bringe sie so 
dazu wortwörtlich eine Geschichte zu erzählen.

1
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#SprechendeGemälde
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Scratch
Scatch ist eine modulare Programmier-
umgebung für Kinder und Jugendliche. 
Sie ist sehr intuitiv und wird meist schnell 
erlernt. Dieses Bild zeigt, an welcher Stel-
le die Töne zu finden sind und wie sie auf 
Tasten gelegt werden können. 
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Raspberry Pi

4 x USB 2.0

40 GPIO Pins

LAN Anschluss
10/100/Gigabit

HDMI Port Audio Klinke
3,5 mm

SD Karten Slot
(unterhalb)

Micro USB 
Power

Broadcom 
Prozessor

+ RAM

2.4GHz and 5GHz IEEE 
802.11.b/g/n/ac WLAN

Bluetooth 4.2, BLE

MIPI DSI display port

MIPI CSI camera port

Der Raspberry Pi ist ein Einplatinencomputer, dh er ist ein komplett einsatzfähiger Computer und 
daher auch leistungsfähiger. 
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empfohlene Hardware 
https://www.raspber-
rypi.org/learning/hard-
ware-guide/



Raspberry Pi Betriebssysteme
(operating system OS) 

New Out Of the 
Box Software
Noobs ist genau 
genommen kein Be-
triebssytem, sondern 
ein Installer und ermög-
licht nur die Installation 
eines OS. 

Noobs

https://retropie.org.uk

RetroPie

Windows 10 IoT

LibreELEC

Windows ist wohl eines der 
bekanntesten Betriebssyste-
me. Windows 10 IoT lässt 
sich auf dem Raspberry Pi in-
stallieren. IoT steht dabei für 
Internet of Things.

LibreELEC ist ein Medi-
en-Player, der das Medi-
en-Center Kodi mit einem OS 
kombiniert. Ein Medien-Cen-
ter spielt Videos, sowie Musik 
ab und zeigt Bilder an. Durch 
installieren von Plug-ins lässt 
sich der Funktionsumfang er-
weitern. Jeder Fernseher lässt 
sich so auch in einen Smart-
TV verwandeln.

RetroPie ist ein Spiele Emulator. Ein Emu-
lator ahmt die Funktionsweise einer ande-
ren Hardware nach, sodass die originale 
Software glaubt, sie befindet sich in der 
originalen Hardware. Mit Hilfe von Retro-
Pie lassen sich Nintendo und Playstation 
Spiele spielen.

Software, die den Betrieb 
eines Computers ermöglicht
Das Betriebssystem vermittelt 
zwischen Hardware, Software 
und dem Anwender 

Direkte Installation mit Etcher: Mit Etcher 
(für Windows, Linux und Mac) lässt sich 
das OS direkt installieren und ist schneller 
als mit Noobs.

Mit Noobs: Mit Hilfe von SD Formatter 
(Windows und Mac) ist es möglich, eine 
SD Karte so zu formatieren, dass anschlie-
ßend lediglich Noobs per drag&drop rauf-
zuziehen ist. Über Noobs lässt sich anschlie-
ßend  ein OS installieren, von der Raspberry 
Pi Foundation wird dabei Raspbian empfoh-
len. Noobs bleibt auf der SD Karte nach ins-
tallieren des OS erhalten und kann beim Start 
über die Shift-Taste geöffnet werden und das 
Betriebssystem erneut installiert werden oder 
ein anderes ausgewählt werden. 

► https://www.raspberrypi.org/learning/software-guide/quickstart/

Installation des OS

Raspbian ist ein Linux Derivat und das 
beliebteste OS für den Raspberry Pi.

Raspbian
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Raspberry Pi Projekte

GPIO steht für General Purpo-
se Input Output. Hier können, 
wie beim Arduino verschiede-
ne Schaltungen mtit Sensoren 
und Aktoren angehängt wer-
den. 

entnommen von https://www.raspberrypi.org/learning/parents-guide/physical/

Diese Pins können nun über 
Python oder Scratch ange-
sprochen werden.

► https://projects.raspberrypi.org/en/projects/physical-computing-with-scratch
Hier findet man eine einfache Anleitung, wie eine LED mit Hilfe von Scratch zum Leuchten gebracht 
werden kann.

► https://projects.raspberrypi.org/de-DE/projects/

Auch die Sensoren, die im Arduino Ka-
pitel vorgestellt wurden, können über 
den Raspberry Pi angesteuert werden.

Hier findet man Schritt-für-Schritt Anleitungen, um kleine Projekte mit dem Raspberry Pi umzusetzen.
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Alexify My Pi
• Raspberry Pi
• MicroSD-Karte 16 GB
• USB-Netzteil
• USB-Mikrofon
• kabelgebundene Laut-

sprecher
• ev USB Soundkarte für 

besseren Klang
• Monitor, Tastatur und 

Maus

Was wird benötigt?

# AlexifyMyPi

Schließe alle Komponenten an und installiere Raspbian 
auf der MicroSD-Karte. Es empfiehlt sich, SSH zu akti-
vieren, dann sind Tastatur, Monitor und Maus nicht nötig, 
sondern der Raspi kann über eine Remote-Verbindung 
eingerichtet werden.

1

Amazon Developer Account

Du hast dich schon immer für Amazons Alexa interessiert, 
aber die dazugehörigen Boxen waren dir zu teuer? Dann 
bastel sie dir doch einfach selber. Der Vorteil zu einem ge-
kauften Alexa-Geräts liegt außerdem darin, dass die Soft-
ware so an deine Bedürfnisse angepasst werden kann. 
Auch Projekte, die eine sprachsteuerung bekommen sollen, 
können so entwickelt werden.

Unter developer.amazon.com kann ein Entwickler-Ac-
count erstellt werden. 
Es muss hier ein sogenanntes Security Profile erstellt 
werden. Dazu muss das zukünftige Alexa Gerät bekannt 
gegeben werden. Ein Wizard hilft durch die Installation.

2

Remotedesktop-Verbindung einrichten:
► https://tutorials-raspberrypi.de/raspberry-pi-remote-desktop-verbindung/

Installation der Beispiel Amazon Alexa App 
Zum Installieren wird das Terminal auf dem Pi aufgerufen.
Mit folgendem Befehl kann das Projekt von Github in das 
Homeverzeichnis geladen werden:

3

git clone https://github.com/alexa/alexa-avs-sample-app.git

cd ~/alexa-avs-sample-app
sudo nano automated_install.sh

Danach müssen die Daten, die zuvor angegeben wurden, 
im automated_install.sh Skript angeben werden. Diese 
Bearbeitung kann über einen Text-Editor oder direkt über 
die Kommandozeile stattfinden.

Hier befinden sich 3 Zeilen, in denen ProductID, ClientID 
und ClientSecret angegeben werden müssen.

Nun kann das Skript gestartet werden. Es werden zu-
nächst einige Fragen gestellt und die Spracheinstellun-
gen eingestellt.

Raspberry Pi
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Starten von Amazon Alexa auf dem Pi
Es werden 3 Instanzen des Terminals benötigt um die An-
wendung zu starten.

1. Zum Starten des Authentifikation Webservices

2. Zur Kommunikation der Anwendung mit AVS

3. Damit das Wort „Alexa“ automatisch erkannt wird und 
die Spracheingabe beginnt

4

cd ~/alexa-avs-sample-app/samples/companionService && npm startTerminal 1:

cd ~/alexa-avs-sample-app/samples/javaclient && mvn exec:execTerminal 2:

cd ~/alexa-avs-sample-app/samples/wakeWordAgent/src && ./wake-
WordAgent -e kitt_ai

Terminal 3:

Genaue Anleitung unter:
► https://tutorials-raspberrypi.de/raspberry-pi-amazon-alexa-deutsch-installieren/

Nun lassen sich Alexa-kompatible Geräte – wie beispiels-
weise Funksteckdosen und Thermostate – ansteuern.
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Game Station

Mache dir Gedanken, welche Arten von Spielen und Spie-
lekonsolen es gibt. Wie funktioniert die Navigation durch 
das Spiel?

1

• Raspberry Pi
• Makey Makey
• SD Karte
• Netzteil
• Maus
• Tastatur
• Krokoklemmen und 

Jumper Kabel

• Schachteln, Karton, ev. 
Holz

• Knetmasse
• Alufolie

Was wird benötigt?

Vorbereiten des Raspberry Pis

Kreieren eines eigenen Spiels

Eine Spielekonsole besteht aus zwei Teilen – einem Rech-
ner und einem Controller. Mit einem Raspberry Pi und Ma-
key Makey kann man sich ohne weiteres seine eigene Ga-
ming-Konsole basteln. Spiele können selbst programmiert 
werden oder man greift auf einen Emulator zurück.

Lade ein passendes Betriebssystem auf den Raspberry 
Pi. Raspbian ermöglicht es mithilfe von Scratch, selber 
Spiele zu programmieren oder über den Browser aus dem 
Internet zu laden. Alternativ ermöglicht der Emulator Re-
tro Pie es, klassische Nintendo-Spiele zu spielen.

2

Falls du dein eigenes Spiel mithilfe 
von Scratch kreieren möchtest, dann 
gehe online und suche dir Tutorials 
aus. 

3

Bedenke, dass die Entwicklung ei-
nes eigenen Spiels sehr lange dau-
ern kann.

mit Bianca Lindorfer

#GameStation

Raspberry Pi
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Das Gehäuse für die Konsole kann aus unterschiedlichen 
Materialien bestehen. Auf den Bildern sieht man einen Nach-
bau eines klassischen Arcade-Automaten. Es ist allerdings 
auch möglich, Modelle aus dem Internet zu laden und mittels 
eines 3D-Druckers zu drucken. Stehen dir diese Möglich-
keiten nicht zur Verfügung, spricht auch nichts dageben, mit 
Karton zu arbeiten.

4

5 Gestalte einen passenden Controller

Gestalte ein passendes Gehäuse

Mit Makey Makey ist es ein Leichtes, einen Cont-
roller selber zu bauen.
Überlege dir:
• Wie wird das Spiel gesteuert?
• Welche Buttons sind unbedingt nötig?
• Wie soll der Controller in der Hand liegen?
• Soll das Design passend zum Spiel sein? Was 

würde denn hier passen?
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► Lisa Kuka

Vom Consumer zum Maker
Handbuch über Single-Board Platinen 

für Lehrkräfte, SchülerInnen und Interessierte

erhältlich unter CodeAndArt.at
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